
PROGRAMARE 1  
 

 1 

 
 
 

PREZENTAREA GENERALĂ  A MEDIULUI DE DEZVOLTARE 
 

1. Mediul de dezvoltare Eclipse 
La sfârşitul anilor ’90, IBM a început dezvoltarea a ceea ce este cunoscut azi ca 

Eclipse. În noiembrie 2001, s-a decis să se adopte licenţierea open source şi modelul 
acestei tehnologii pentru a accelera adoptarea Eclipse ca platformă globală de dezvoltare. 
Principiul de bază al consorţiului a fost următorul: comunităţile open-source vor dirija 
programarea, iar consorţiul comercial va promova produsul respectiv. Aceasta era o nouă 
si interesantă aplicaţie a modelului open source, bazată pe o platformă gratuită şi 
deschisă. Pentru mai multe informaţii accesaţi: 

• www.eclipse.org 
• http://www.ibm.com/developerworks/rational/library/nov05/cernosek/ 

 
Eclipse este mediul de dezvoltare integrat (IDE – Integrated Development 

Environment) pe care îl vom folosi pentru scrierea programelor C. El permite dezvoltarea 
de aplicaţii în mai multe limbaje de programare: Java, C, C++, C#. În cadrul laboratorului 
vom scrie programe C de tip consolă. 
 

Pentru instalarea versiunii de lucru trebuie accesate următoarele link-uri: 
a) Jave SE Runtime Environment (JRE) 
 
b) Mediul de dezvoltare Eclipse 
http://eclipse.org/downloads 

Se selectează IDE (Integrated Development Environment) pentru C 
Eclipse IDE for C/C++ Developers 

 
c) Pentru cazul în care se lucrează pe sistemul de operare Windows, trebuie instalat 

compilatorul de C  (MinGW – care este varianta pentru Windows a gcc – compilator și link 
editor pentru C/C++) și eventual debuggerul (programul de depanare) gdb. În cazul în 
care se lucrează pe Linux sau MacOS atât gcc, cât și gdb vin instalate odată cu sistemul 
de operare. 
 

Pentru informaţii suplimentare referitoare la instalarea Eclipse se accesează  pagina 
Welcome a mediului (Help->Welcome) se alege secţiunea Tutorials, apoi C/C++ 
Development şi din panoul din stânga C/C++ development User Guide -> Before you 
begin. 

 

2. Pornirea aplicaţiei 
În primul rând se face precizarea că explicațiile care urmează (în cazul în care nu se 

specifică altfel sunt valabile pentru toate cele trei sisteme de operare amintite mai sus 
(Windows, Linux, MacOS) 

Pentru a lansa mediul de dezvoltare Eclipse se face dublu clic pe fişierul eclipse 
existent în directorul în care a fost instalată aplicaţia sau pe icoana corespunzătoare de pe 
desktop. Apare fereastra Workspace Launcher (prezentată în Figura 1). Această 
fereastră permite alegerea directorului în care vor fi stocate proiectele realizate. În 
exemplul din Figura 1 se stabileşte ca director de lucru directorul c:\Temp. Faceţi clic pe 
OK pentru a confirma alegerea directorului de lucru. 
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Figura 1. Fereastra Workspace Launcher. 

 
După închiderea ferestrei Workspace Launcher apare fereastra Welcome (Figura 2) 

dacă mediul Eclipse este lansat pentru prima dată, sau fereastra mediului de dezvoltare 
(prezentată în Figura 3). Fereastra Welcome poate fi reafişată din Help->Welcome. 

 
Figura 2. Fereastra Welcome a mediului Eclipse 

 
 Închiderea ferestrei Welcome are ca efect apariţia ferestrei mediului de dezvoltare 
(Figura 3). 
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Figura 3. Fereastra mediului de dezvoltare 

 

3. Crearea unui proiect 
Pentru fiecare problemă pe care trebuie să o rezolvăm trebuie să creăm un proiect. 

Pentru a crea un proiect nou alegem File -> New -> C Project (Figura 4) 
 

 
Figura 4. Deschiderea unui proiect C nou 
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Selectarea opţiunii C Project are ca efect afişarea ferestrei C New Project wizard, 
după cum este prezentat în Figura 5.  

În câmpul Project Name se introduce numele proiectului (în Figura 5 este 
MyFirstProgram). Pe măsură ce se tastează numele programului, câmpul Directory devine 
c: \ Temp \ MyFirstProgram. Se alege tipul proiectului (din meniul Project types) ca fiind 
Empty Project. Se poate alege tipul de compilator pe care îl folsim din meniul Toolchain. 
În acest caz singurul compilator instalat este MinGW GCC după cum este prezentat în 
Figura 5 (care este compilatorul implicit în această instalare). Pentru Linux trebuie selectat 
Linux GCC, iar pentru MacOSX GCC. 

 

F 
Figura 5: Deschiderea unui nou proiect cu numele MyFirstProgram 

 
Se selectează Finish pentru a finaliza crearea proiectului C. 
Se deschide proiectul în perspectivă C. O perspectivă defineşte setarea iniţială a 

modului de vizualizare în fereastră. Perspectiva controlează ceea ce apare în anumite 
meniuri şi bare de instrumente. 

Proiectul este creat şi deschis, ar trebui să vedem fereastra Project explorer – în 
partea stângă. De aici se pot crea sau deschide fişierele proiectului. Iniţial proiectul  
conţine (în mod implicit) fişierele header de bibliotecă disponibile (Figura 6). 
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Figura 6. Fereastra iniţială a proiectului 

 
 Putem stabili un stil de scriere pentru programele sursa din Window->Preferences 

 
Figura 6a. Alegerea opţiunilor mediului 

 
 Pentru lucrările de laborator din acest semestru vom utiliza stilul BSD/Allman 
(built-in) (Figura 6b). 
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Figura 6b. Alegerea stilului de scriere a codului. 

 
3.1. Adăugarea de fişiere la proiect 

Pentru a putea scrie cel mai simplu program C în Eclipse, trebuie să adăugăm 
fişiere sursă / header. Pentru început vom adăuga directorul src, iar în acest director vom 
adăuga fişierele proiectului. Pentru crearea directorului src vom executa următorii paşi  

• Selectare folder MyFirstProgram în Project Explorer 
• File / New / Folder 
• Selectare Folder name: src 

Acum vom adăuga următoarele fişiere în directorul src: 
• FirstProgramMain.c fişierul care va conţine funcţia main 
• MyFunction.h fişierul care va conţine definiţia funcţiilor 
• MyFunction.c . fişierul care va conţine implementarea funcţiilor 
 



PROGRAMARE 1  
 

 7 

 
Figura 7: Creare director src. 

 
Pentru adăugarea celor trei fişiere vom executa următorii paşi: 

1. Adăugare fişier header (Figura 8): 
• Selectare folder src în Project Explorer  
• File / New / HeaderFile 
• Scrieţi numele fişierului header Header File: MyFunction.h - figura 8. 

 

 
Figura 8: Adaugare fişier header. 

 
2. Adăugare fişiere sursă (Figura 9) 

• Selectare folder src în Project Explorer  
• File / New / SourceFile 
• Scrieţi numele fişierului sursă  Source File: MyFunction.c - figura 7 
• File / New / SourceFile 
• Scrieţi numele fişierului sursă  Source File: FirstProgramMain.c 
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Figura 9. Adăugare fişier sursă. 

 
 Atenţie: când adăugaţi fişiere header sau fişiere sursă este obligatoriu să precizaţi şi 
extensia acestora. 
 
3.2 Scrierea primului program 

Să se scrie un program care citeşte de la tastatură trei numere întregi şi afişează 
maximul lor. 

 
Selectaţi din Project Explorer fişierul care vreţi să-l editaţi (clic pe el), apoi scrieţi 

codul C dorit: 

 
Figura 10. Eclipse IDE după adăugarea fişierelor proiectului 
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Mai jos este listat codul sursă din cele trei fişiere ale aplicaţiei. 
Observaţie: Fiecare student va completa cu numele său linia de comentariu care se 

referă la autorul programului. 
 

/* 
 * MyFunction.h - Proiect MyFirstProgram 
 *  
 *   Creat pe 11.02.2009  
 *   Autor <nume autor program> 
 *  Copyright 2009 
 *  
 * Descriere Fisierul cu prototipurile functiilor  
 *  pentru primul proiect 
 */  
 
#ifndef MYFUNCTION_H_ 
#define MYFUNCTION_H_ 
 
int maxim(int x, int y, int z); 
 
#endif /* MYFUNCTION_H_ */ 
 
/* 
 * MyFunction.c - Proiect MyFirstProgram 
 *  
 *   Creat pe 11.02.2009  
 *   Autor <nume autor program> 
 *  Copyright 2009 
 *  
 * Descriere: Functiile pentru primul proiect 
 */ 
#include "MyFunction.h" 
 
/* 
 * maxim – Functie pentru determinarea maximului dintre numere 
 *    intregi 
 * Parametri de intrare: trei numere intregi 
 * Parametri de iesire: maximul dintre cele trei numere 
 */ 
  
int maxim(int x, int y, int z) 
{ 
 int nrMaxim; 
 
 if (x > y) 
 { 
  nrMaxim = x; 
 } 
 else 
 { 
  nrMaxim = y; 
 } 
 if(nrMaxim < z) 
 { 
  nrMaxim = z; 
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 } 
 return nrMaxim; 
} 
 
/* 
 * FirstProgramMain.c - Proiect MyFirstProgram 
 *  
 *   Creat pe 11.02.2009  
 *   Autor <nume autor program> 
 *  Copyright 2009 
 *  
 * Descriere: Fisierul cu functia main pentru primul proiect  
 *    de calculare a maximului dintre 3 numere 
 */ 
 
#include <stdio.h> 
#include "MyFunction.h"  
 
int main(void) 
{ 
 int nr1, nr2, nr3; 
 int max; 
 
 printf("Citeste primul numar: "); 
 scanf("%d", &nr1); 
 printf("Citeste al doilea numar: "); 
 scanf("%d", &nr2); 
 printf("Citeste al treilea numar: "); 
 scanf("%d", &nr3); 
 
 max = maxim(nr1, nr2, nr3); 
 printf("Cel mai mare numar este %d\n", max); 
  
 return 0; 
} 
 
3.3 Compilarea şi rularea proiectului. Detectarea erorilor. 

Pentru a compila proiectul selectăm din meniul principal Project → Build Project.  
Atenţie: ceea ce se compilează este codul de la ultima salvare. De aceea salvaţi 

întotdeauna înainte de compilare: CTRL + S. 
Dacă sunt detectate erori de compilare, în partea de jos a ecranului va apărea 

fereastra Problems. Să introducem intenţionat o eroare, de exemplu, putem înlocui linia 
“scanf(“%d”, &nr);” cu “scanf(“%d”, &nr)” scoţînd “;”. La compilare, compilatorul îşi dă 
seama că lipseşte “;” şi afişează în fereastra Problems următorul mesaj: 
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Figura 11. Compilare cu erori 

 
Atenţie: se observă “X” - ul roşu cu care este marcat atât fişierul, cât şi linia unde a 

apărut eroarea. 
Dacă dăm dublu-clic pe mesajul de eroare, cursorul se va deplasa la linia de cod 

conţinând eroarea. În general s-a observat următoarea regulă – eroarea trebuie căutată ori 
pe linia afişată în error list, ori cu o linie mai sus. În exemplul nostru, mesajul de eroare ne 
duce cu o linie mai jos. 

După compilare, link-editare şi eliminarea tuturor erorilor lansarea în execuţie se poate 
face (pentru Windows) în două moduri: 

A. Folosind Command prompt din Windows (cmd.exe) 
• pornim cmd.exe: Start /Run 
 

 
Figura 12. Rulare cmd.exe 

 
• din linia de comandă a aplicaţiei cmd, folosind comanda MS-DOS cd (change 

directory), setăm directorul în care se găseşte programul executabil (fişierul de 
tip exe).  
Alte comenzi MS-DOS utile: 

type <nume_fisier> - listează pe monitor conţinutul fişierului <nume_fisier> 
dir – listează toate fişierele din directorul curent  

• lansăm în execuţie fişierul exe rezultat în urma link-editării tastând numele dat 
proiectului: MyFirstProgram 

 Observaţie: pentru fişierele de tip exe (executabile) nu este necesară indicarea 
extensiei atunci când sunt lansate în execuţie. 
 
 B. Folosind Total Commander 

• lansăm în execuţie Total Commander şi ne poziţionăm pe subdirectorul Debug 
al directorului în care se găseşte programul sursă (Figura 13). 
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Figura 13. Fereastră Total Commander 

 
• Selectăm din meniul Command à Run Dos (Figura 14). 

 
Figura 14. Lansarea în execuţie a MS-DOS 

 
• Apare fereastra MS-DOS din Figura 15. 

 

 
Figura 15. Fereastera MS-DOS 
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• Se lansează în execuţie prin tastarea numelui programului (aici p1). Numele 
programului coincide întotdeauna cu numele proiectului. În Figura 16 este 
fereastra MS-DOS în care s-a executat programul p1 (care cere numele 
utilizatorului şi afişează mesajul Primul program in C) 

 

 
Figura 16. Lansarea în execuţie şi rularea programului p1 

4.  Deschiderea unui proiect existent 
Pentru a încărca un proiect existent se vor executa următorii paşi: 
Selectaţi File / Import  
Selectaţi General / Existing Projects ca în figura de mai jos. Apăsaţi butonul Next. 
 

 
Figura 17. Deschiderea unui proiect existent 

 
• Apăsaţi butonul Browse şi selectaţi directorul în care se află aplicaţia: 

C:\Temp\MyFirstProgram 
• Bifaţi proiectele dorite din lista Projects. În cazul nostru avem doar un proiect în 

directorul specificat – Figura 18. 
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Figura 18. Selectare proiecte. 

 
• Faceţi clic pe Finish pentru a încărca proiectul. 

5. Utilizarea debuger-ului 
Debuger-ul din acest mediu integrat este puternic şi uşor de folosit. Pentru a starta 

aplicaţia în modul debug: 
• Clic Run / Debug (F11).  
• În acest moment veţi fi întrebaţi dacă doriţi să deschideţi perspectiva debug. O 

perspectivă defineşte setarea iniţială a modului de vizualizare în fereastră. 
Perspectiva Debug conţine moduri de vizualizare ce sunt folosite pentru 
depanare de programe (clic pe yes). În acest moment aplicaţia se va deschide 
în modul debug după cum este prezentat în Figura 19.:  

 

 
Figura 19. Perspectiva Debug. 
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• Acum putem trasa aplicaţia pas cu pas. Există câteva butoane pe care le vom utiliza 

pentru a depana proiectul nostru (meniul Run): 
o Butonul "Resume" - F8 este folosit pentru a relua executarea până când se 

termină sau întâlneşte un alt breakpoint.  

o Butonul "Stop" CTRL-F2 va opri procesul de depanare.  
o Butonul "Step into" – F5 va executa codul linie cu linie şi va intra în metodele 

care vor fi apelate. Altfel, se va comporta ca butonul "Step over".  

o Butonul "Step over" – F6 va executa codul linie cu linie fără a intra în 
metode.  

• Apăsaţi F5 şi observaţi linia la care a ajuns programul, linia selectată este linia care 
se execută când apăsaţi F5. Când aţi ajuns pe instrucţiunea scanf (citeşte un 
număr de la tastatură) apăsaţi încă o dată F5, apoi introduceţi valoarea primului 
număr în consolă ca în figura de mai jos: 

 

 
Figura 20. Debug pas cu pas. 

 
• Variabile: uitaţi-vă la cadrul dreapta sus la fereastra Variables aici vor apărea 

valorile variabilelor. Parcurgeţi liniile de cod pas cu pas apăsând butonul Step over 
(F5 ca o comandă rapidă), uitaţi-vă în fereastra Variables. O dată ce o nouă 
variabilă este iniţializată va apărea acolo şi atunci când ea îşi schimbă valoarea, se 
va actualiza automat.  

• Se vor introduce valorile nr1= 3, nr2 = 76, nr3 = 43. Observaţi că, apăsând F5 când 
linia selectată este: printf("Cel mai mare numar este %d", maxim(nr1, nr2, nr3)); se 
va trasa codul funcţiei maxim, urmăriţi ramurile de execuţie ale algoritmului în 
cadrul acestei funcţii. 

• Puteţi pune un breakpoint pe o anumită linie: 
o selectând linia respectivă - de exemplu: printf("Citeste al doilea numar: ");  
o apăsând CTRL + SHIFT + B sau meniul Run – Toggle Breakpoint acum 

aplicaţia se va opri la fiecare execuţie în mod debug la linia ce conţine 
breakpointul. 
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Fiecare problemă se va rezolva folosind un proiect care va conţine: 
- un fişier header cu prototipurile funcţiilor folosite 
- un fişier cu funcţia main 
- un fişier cu funcţiile din program 

(După modelul de la curs). 
De asemenea, pentru fiecare problemă se va face o analiză pentru identificarea 

datelor de intrare şi de ieşire din program şi din fiecare funcţie, a algoritmilor folosiţi, cât şi 
a seturilor de date de test). 

 
 


